
Music
is

the
Message

Use algorithmically generated music to place an interpretation upon a film scene



2 T h e  M u s i c  i s  t h e  M e s s a g e

Software: YAV Interactive Media
Concept and Research: Christopher Yavelow

(including but not limited to: algorithmic composition,
automatic film synchronization, and psychoacoustic factors)

Programming and Human Factors: Christopher Yavelow,
Anton Pieter Van Grootel

YAV Music Engine™ conceived and developed by: Christopher Yavelow

Primary Interface Graphics: Brentano Haleen

Interface Controls: Anton Pieter van Grootel, Brentano Haleen

Additional Graphics: Ingrid Joustra, Jolanda Mulder,
Leontine Seuren, Koen Zijm

Translations: Monique Fasel, Anton Pieter van Grootel

CD-ROM and User-Guide Cover Graphics: Celina Yavelow

Video : Amber Film
De Benadering (Approach): a polyvalent filmscene

Script and Direction: Mart van den Busken

Cast: Toinette Loeffen, Joost Küpper, Diana Issidorides

Crew: George Welman  (CAM), Jaap Veldhoen  (LIGHT),
Carolien Euser  (PROD)

Exhibit: newMetropolis
Concept and Research: Diana Issidorides, Irit Rosen, Peter Slavenburg

(including but not limited to: visitor experience,
ambiguous film clip, contractors, layout, and furniture)

The Music is the Message is © 1997, 1998 by YAV Interactive Media
Portions © 1989-1997 Allegiant Technologies. Inc.

HyperMIDI © 1997 EarLevel Engineering.
This application was created using SuperCard 3.0,

YAV’s RAD Tools, Spike, HyperMIDI, and CompileIt!
YAV, YAV Music Engine, YME, YAV’s RAD Tools, and Spike

are trademarks of YAV Interactive Media.

YAV Interactive Media:
Brederodestraat 47
2042 BB  Zandvoort
The Netherlands

phone: +31-23-5716282
fax: +31-23-5716245

email: Bytehoven@yav.com
website:  www.yav.com



T h e  M u s i c  i s  t h e  M e s s a g e 3

Contents

1 Overview ..............................................................4
Operation............................................................................................. 4
The YAV Music Engine ....................................................................... 5
Adaptive Music™ ................................................................................ 5
The Exhibit (Kiosk Version) ................................................................. 6
Perspective.......................................................................................... 6

2 Setup ....................................................................7
Hardware ............................................................................................. 7
Software Installation ............................................................................ 8
Icons .................................................................................................... 9

3 Quick Tour .........................................................12
How to Begin ..................................................................................... 13
Start Window ..................................................................................... 14
Edit Window ...................................................................................... 15
Edit Window, Storyboard .................................................................. 16
Edit Window, Rhythm Screen ........................................................... 17
Edit Window, Melody Screen ............................................................ 18
Edit Window, Texture Screen ........................................................... 19
Edit Window, Volume Screen ........................................................... 20
Composing your Soundtrack............................................................. 21
The Playback Window....................................................................... 22
The Playback Window, Orchestration ............................................... 22

The six default orchestrations categories ...................................................... 22
The Playback Window,Playing your Soundtrack .............................. 24
Generating New Soundtracks from the Playback Window ............... 25
Saving Your Soundtrack ................................................................... 26
The Archives Window ....................................................................... 27

4 Configuration ....................................................28
The Configuration Window,
Learning Setup .................................................................................. 29
Models (folder) .................................................................................. 29
The Configuration Window, Serendipity Setting ............................... 30

Probabilities of Randomness by Serendipity Setting ..................................... 30

5 History ................................................................31
User History Abbreviations ............................................................................ 33

6 Menus .................................................................34
Apple Menu ....................................................................................... 34
Options Menu (kiosk mode) .............................................................. 34
Help Menu ......................................................................................... 35
Full Menus (non-kiosk mode) ............................................................ 36
File Menu........................................................................................... 36
Edit Menu .......................................................................................... 37
Windows Menu .................................................................................. 37
Configure Menu ................................................................................. 38
Soundtrack Menu .............................................................................. 42
MIDI Menu ......................................................................................... 43
Utility Menu........................................................................................ 44
Internet Menu .................................................................................... 47
Archive Management Popup Menu................................................... 48
Using Archive Management .............................................................. 51
More about moods and models ........................................................ 52

7 Technical Information .......................................52
More about built-in constraints .......................................................... 53

Mood-dependent Constraints ........................................................................ 53
Observations: .................................................................................... 54

8 Keyboard Shortcuts ..........................................56
General .............................................................................................. 56
Help Window ..................................................................................... 56
Edit Window ...................................................................................... 56
Archives Playback Window ............................................................... 56
Archive Window ................................................................................ 57
Menu Shortcuts ................................................................................. 58



4 T h e  M u s i c  i s  t h e  M e s s a g e

Overview

The Music is the Message generates film and video soundtracks. The program continually
adapts its internal compositional models according to feedback from its user or users. The
software is an example of “adaptive music™,” a term coined by the program’s developer,
Christopher Yavelow, who also developed the “YAV Music Engine™”(YME), the core
software engine that creates new music.

Operation

The Music is the Message lets you compose music for a short film clip. The program uses
the YAV Music Engine™ to generate new music in three moods: Romance, Comedy, and
Thriller. The YME kernel uses an expert system (related to artificial intelligence) to
simulate musical creativity. Certain musical characteristics are assigned to each mood,
for example, those relating to form, tempo, rhythmic patterns, and key. Depending upon
the mood, the YME kernel uses different algorithms to transform musical themes, for
which you provide the seed material.

After choosing a mood, you use the edit screens to configure the rhythmic world, melody,
allowable textures, and volume curve for your music. Here you can also decide which
audio-video synchronization points should have music. In addition to other configuration
controls, each edit screen provides a “computer choice” button which generates an
appropriate configuration for that screen’s parameters, based upon what the software has
“learned” about you or the group of people using the software. At this particular juncture
and depending upon the degree of “serendipity” configured in the setup process, the
software may, from time to time, choose to interject a completely random configuration.

After you are satisfied with the current configuration, you instruct the software to
generate a soundtrack for the video. The soundtrack is synchronized to as many of the 28
sync or “hit” points as possible. These include but are not limited to the cuts, zooms, and
other camera manipulations or scene changes in the clip. After you view the video with
your soundtrack you are asked to rate its effectiveness. Likewise, anyone else recalling
your clip from the archives will be requested to provide a rating. The software uses these
ratings to determine which soundtracks should be considered the next time it adapts its
compositional model.

 

1
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The YAV Music Engine

The YAV Music Engine is a modular technology incorporating an expert system
engine that creates credible music in a variety of styles (expert systems are loosely
related to artificial intelligence). For the composer, YME offers a means to realize
musical works according to diverse specifications. For the interactive media producer
or film and video maker, YME provides unique, original, and copyright-free music in
a very flexible manner.

The YAV Music Engine creates new, hitherto unheard music rather than taking the
increasingly prevalent approach of re-organizing canned music. Many people confuse
interactive audio with interactive music. It is simpler to say ‘I am listening to music’
than ‘I am listening to the sound of music being performed.’ Until recently, there has
been no reason to make a distinction between music and the sound of music (audio).
People use the word ‘music’ to refer to music as an art form, and to the printed
symbols representing expressions of this art form, and to the audible sounds of these
symbols being performed. Now, technology requires that we clarify these terms. True
interactive music must actually compose new music and, therefore, such software
must “understand” the semantics of music itself, not simply the mechanics required to
spit out re-ordered, re-mixed fragments of existing audio-recordings. In adhering to
this premise, The Music is the Message models the actual compositional process,
which is orders of magnitude beyond automated ‘cut, copy, and paste.’

Adaptive Music™

Adapative Music relies on a continual feedback loop consisting of a user or users
evaluating music generated by seed material provided by themselves, so that the
software can incorporate their preferences, opinions, and tastes into subsequent
compositions by adapting the methods and models it uses to compose in the future.

The process of adapting compositional models includes identifying all soundtracks
that have received high ratings and grouping them according to mood. Next, the
current version of The Music is the Message analyzes 32 aspects of each soundtrack
to construct its compositional model (actually three models, one for each mood). For
example, in the pitch domain the software considers the individual notes of each
melody according to their position, the frequency of and direction of intervals, the
overal contour, and the length of the melody. The software similarly scrutinizes sync-
points, rhythms, textures, volume and instrumentation in constructing its models.

The Music is the Message can be configured to adapt (“learn”) at a specified time
each day or whenever directly requested. Each time the software adapts itself, it
creates a new compositional model and this becomes the active model used both by
the “computer choice” buttons and by the main engine for generating music. Models
canbe saved and recalled at any time.
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The Exhibit (Kiosk Version)

YAV created The Music is the Message for the newMetropolis Science and Technology
Center in Amsterdam, The Netherlands. The kiosk version of the software installed at the
museum uses a short video clip produced by Amber Film. The clip is intentionally
ambiguous so that its interpretation rests solely upon the soundtrack. The film’s creator,
Mart van den Busken, refers to this as a “polyvalent” film.

In kiosk mode the adaptive aspect of the software occurs as follows: every morning about
an hour before the museum opens, the software analyzes all the soundtracks that have
been composed up to that date (thousands of files). Each soundtrack has been rated by the
user who provided its seed material, and soundtracks auditioned by other visitors have
been rated as well. The software uses these ratings to determine which settings produce
the best music, ranks them accordingly, and redefines its internal compositional models
to reflect this collective opinion poll.

At the newMetropolis, this learning process allows the software to continually move
closer to the ideal soundtrack as delimited by the ever-growing number of exhibit
visitors. In contrast to this multicultural melting pot, the personal edition of the software
adapts its behaviour to the tastes of a single individual.

Perspective

This is version 1.0 of a technology for which we have great plans.

We started working in The Music is the Message at the end of March 1997. We installed
the first version at the newMetropolis Center for Science and Techology on the first of
June. We had to develop another CD-ROM for LEGO during the summer of 1997 and
were able to return to this work in the middle of September 1997.

According to the specifications of the kiosk version, it was necessary to provide the
museum visitor with a meaningful experience within six minutes. That placed strong
limitations on what we were able to provide for with respect to user control.

Although we have designed more than 400 compositional algorithms for the YAV Music
Engine, time considerations dictated that we could only implement about 40 of these (less
than one-tenth) into version 1.0 of The Music is the Message.

At this time, the construction of the compositional models (the “learning process”) looks
more at the seed material than at the music generated by that seed material. Subsequent
versions of The Music is the Message will equalize these two perspectives.

Future versions of this product will also add more compositional algorithms, more user
control options (including options to directly enter rhythms rather than create a symbolic
“rhythmic world”), a stylistic module capable of emulating another composer’s style with
generated output, and much more.

Keep watching this space!

Christopher Yavelow
January 1998.
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2 Setup

Hardware

To set up your computer for The Music is the Message you need an external General
MIDI (GM) sound module and, optionally, some means of amplifying the sound
output of your computer.

The soundtracks created by The Music is the Message consist of MIDI data. The
sound effects embedded in the video consist of standard audio data that will play back
through your computer’s speakers.

A very simple configuration is to connect a Korg 05R/W sound module to your
modem port (or printer port). Merge the Macintosh’s headphone output  with the
sound module’s headphone output by way of two “Y” connectors into which you
have plugged a set of headphones. Alternatively, you can use loudspeakers instead of
headphones.

If you don’t have an external General MIDI sound module, you may be able to route
the MIDI data from The Music is the Message to the QuickTime General MIDI
synthesizer. This emulates (in software) a Roland GS synth with the same instrument
set as a Sound Canvas SC55ST.

The technique for routing the MIDI output of The Music is the Message to the
QuickTime software synthesizer is tricky and depends upon too many variables to
describe here. We hope that future versions of the software will route the output
directly to QuickTime’s software synthesizer for those who do not own a sound
module.

We have included a player called “MIMshow” that demonstrates (using the
QuickTime software synthesizer) some of the first 24 sample soundtracks created by
The Music is the Message.

Set your monitor to the highest possible color resolution (millions of colors, if
possible). You don’t need to set a monitor size larger than 640 by 480, although
larger monitor sizes are supported.
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50 MB

Software Installation

The installer gives you several choices for installation.

1) Recommended installation: This installs the software, without any extra archive collec-
tions, and Apple’s MIDI Manager for routing the MIDI data generated by The Music is the
Message to an external synthesizer. This installation requires 55 MB.

2) Custom installation 1: This installs the software with the extra archive collections, and
Apple’s MIDI Manager. This is the full 126 MB installation.

3) Custom installation 2: Software with extra the archive collections, but without MIDI
Manager (125 MB).

4) Custom installation 3: Minimal software only, without extra archive collections, and
without MIDI Manager (55 MB).

5) Custom installation 4: Extra archive collections only (70 MB).

6) Custom installation 5: MIDI Manager only (in case you change your mind and want to
install it at a later date (< 1 MB).

4.3 MB

70 MB
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Icons

Main Program icon

Soundtrack (Standard MIDI File)

Settings file

Compositional Model file

MIMratings file

User History file

Preset Bundle

The 70 MB Archive Collections
folder is optional. You can leave
this on the CD-ROM and pick
and choose which collections you
want to experiment with (if any).
Each folder contains an Archives
folder and an associated Settings
folder. To experiment with a
particular collection, open its
folder and copy those folders to
your main MIMfiles folder on
your hard drive (you may want to
back up the Archives and
Settings folders that are already
in your MIMfiles folder prior to
replacing them).
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MIDI Manager

Components from Apple’s (unsupported) MIDI Manager is installed by many of the
installation options. MIDI Manager gets installed in your Extensions folder. The Apple
MIDI Driver and PatchBay Help gets installed loose in your System Folder. PatchBay is
installed in your Apple Menu Items folder.

While The Music is the Message is running with MIDI Manager, you should be able to
open PatchBay from the Apple Menu and see the following configuration:

If the connections
are made as
illustrated, you may
need to draw a
connection between
the output ports so
that they resemble
this diagram.

If the ports on the left are not available, you may need to double click on the left-side
port icon to call up the Apple MIDI Driver Settings window:

This is a likely configuration
of the Apple MIDI Driver
Settings window.
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YAV Software Extras

There is a folder on the CD-ROM called YAV Software Extras:

You can use the installers in the
YAV Software Extras to install
three shareware programs by
YAV: CyberMozart,
PushBtnBach, and Spike.

CyberMozart  (version 3.0) re-creates Mozart's Musical Dice Game. Mozart did not
have a computer so he threw two dice a total of sixteen times to choose items from
his list of 176 measures. You merely have to press the "Compose" button to create a
new English Country Dance (there are trillions of possibilities). The program will
keep generating new pieces in the style of Mozart as long as you can keep pressing
the Compose button. Other features include notation with scrolling playback, print-
ing, saving as Standard MIDI Files, and real-time editing options for tempo, transpo-
sition, track volume, and instrumentation.

PushBtnBach (version 2.0) is an example of algorithmic composition software.
PushBtnBach keeps generating new minuets in the style of Bach as long as you can
keep pressing the Compose button. Version 2.0 introduces a “continuous mode,”
which keeps generating and playing without intervention. Other features include
saving as Standard MIDI Files, real-time instrumentation changes, and a preview of
some of the options available with the non-shareware version (check the Options item
under the PushBtnBach menu).

Spike  (version 1.6) is the first batch-processing data-spike detection and analysis
tool for QuickTime movies. Spike solves the stutter and glitch playback problems of
CD-ROM and Web-based QuickTime files. Given a batch of QuickTime movies,
Spike determines which among them will provide optimal playability from a range of
deployment platforms and media. Offering many of the features of Apple's long-
discontinued MovieAnalyzer, Spike is compatible with QuickTime 2.5 and beyond.
Spike identifies data spikes and offers a suite of options for controlling their detec-
tion. Other features include detailed data-rate graphs, "Spike Alerts" and reports in
frames-per-second and SMPTE, several preview options, and batch processing.

MIMshow is a small program that allows you to view the Music is the Message
video with some of the 24 sample soundtracks that are the default installed collection.
You can use the application to view and listen to these soundtracks without having an
external synthesizer or sound module. Playback will be routed to the QuickTime
software synthesizer described elsewhere in this documentation.
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3 Quick Tour

This quick tour assumes that you are in kiosk mode. Once you have learned how to
operate the program in kiosk mode, operating the program in non-kiosk mode very
simple. (Note, but don’t do it now: to switch out of kiosk mode, uncheck the “Kiosk”
item under the “Options” menu).

Kiosk mode means that the menubar is not visible at the top of the screen. To view the
menubar, move the mouse to the top of the screen. If the menubar does not appear then
move the mouse to the top of the screen while holding the option (alt) key down. In kiosk
mode, the menubar contains a single menu named “Options.” In non-kiosk mode the
menubar is always visible and contains eight menus that provide quick control of all the
software’s options.

The layout of most screens you interact with while using The Music is the Message
includes a small information field at the lower left. Here you see brief descriptions of the
functions of various controls as you roll the mouse over those controls. At the lower right
are controls to switch the language (English or Dutch), to start over (circle with a
diagonal line through it), and to access “Quick Help” (the button shaped like a question
mark).

Important keyboard shortcuts to know before you begin are: you can press the Left arrow
key or the Right arrow key to go the previous or next screen, respectively. Command-
equals (=) takes you to the Preferences window. On some computers when running in
kiosk mode, it is necessary to click the mouse (anywhere) before the keyboard shortcut
will provoke a response (this is not the case in non-kiosk mode).

While taking the tour, you may wish to iconize the Help window at the Quick Tour
chapter so that you can recall it whenever you want to read the next step. To iconize the
Help window, click on the grow box in the upper right corner of the window. This
reduces it to a floating icon. Click anywhere on the icon to re-open the Help window.

If you haven’t read the Overview and Setup sections of this documentation, you should
do that now.
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How to Begin

You can start the tour in the Archives window by experimenting with soundtracks
that have already been created, or you can start at the Start window and begin creating
your own soundtracks immediately.

If you chose to start the tour by listening to soundtracks that have already been
created by other users working with The Music is the Message then go to the Ar-
chives window by selecting it from the Options menu (in kiosk mode) or the Win-
dows menu (in non-kiosk mode). The keyboard shortcut, command-F, also takes you
to the Archives window. Otherwise you can jump directly to the section headed “Start
Window” below.

You see a scrolling list of soundtracks in the Archives screen. Clicking on a
soundtrack name loads that soundtrack for playback and takes you to the Archives
Playback screen where you can view the video with that soundtrack. Alternatively,
you can hold the option key down while you click on a soundtrack in the scrolling list of
the Archives window; this plays that soundtrack immediately without showing the video.

You can navigate the scrolling Archive list using the up and down arrow keys with or
without the option key. If you hear a soundtrack that you especially like, you may
want to click on its name while holding the shift key down (alternatively, press
command-right bracket), which loads the settings for that soundtrack into the edit
screens described below. It is sometimes a good idea to have some settings you know
you like to start with when you begin creating your soundtrack.

Press the right arrow key or the triangular “Next” button twice to navigate back to the
Start window. Alternatively, you can press the “Start Over” button at the lower right
corner of the screen to go directly to the Start window.

There are many keyboard
shortcuts available in the
Archives window. You can
read about these in the
“Keyboard Shortcuts”
chapter of the
documentation.

Pressing the mouse button
while the cursor is over the
word “Archives” will bring
up the Archives Management
popup menu if you are
operating in non-kiosk mode.
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Start Window

Start at the main screen (Start window). This is the one with three large buttons on the
right labeled Romance, Comedy, and Thriller. Note the colors associated with the three
moods: red for romance, greenish-yellow for comedy, blue for thriller.

At the bottom of this screen
is a “Preview” button. You
may wish to preview the
video clip without a
soundtrack by clicking on
this button to go to the
Preview screen. There you
see VCR-like controls that
let you play the film
forwards, backwards, fast-
forward, pause, and rewind
to the beginning. You hear
the sound effects but not the
soundtrack (because you
haven’t composed one yet).

You can disable or adjust the volume of the sound effects (which are output from the
computer’s headphone or sound output jack). To do so, select “Preferences” from the
“Utilities” menu or select “Preferences” from the “File” menu if you are not in kiosk
mode (alternatively, press command-equals). The controls for the sound effects are found
at the lower right of the configuration screen. Make the desired changes and click on the
Back button to return to the Start window.

The video clip is intentionally ambiguous. It relies upon music to endow it with a
Romantic, Comedic, or Thriller character. While you are watching the clip, decide what
mood you would like the music to instill in the clip.

Press the Next or Previous
buttons (large triangular
buttons at the lower right
and lower left of the
screen) to return to the
Start window from the
Preview screen.

Note the colors
associated with the three
moods: red for romance,
greenish-yellow for
comedy, blue for thriller.

The background of the
Preview window has not
been assigned a color
because you haven’t
 picked a mood yet.
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Choose one of the three moods (Romance, Comedy, or Thriller) by clicking on its
corresponding button at the right side of the screen. Making this choice places certain
constraints upon the methods and models that will be used to generate the music.
These constraints are described in greater detail in the section entitled “Technical
Information.”

While you move from the Start window to the Edit window you may notice a red dot
flash momentarily in the upper right corner of the screen. Whenever a red dot flashes
up there (or on the Reconfigure button while in the Playback window), this indicates
that the software has made a serendipitous choice for one of the parameters. In other
words, rather than generating a choice from its composition model, it has introduced
some randomness. Usually the software will make decisions based upon the model,
but you can change the degree of serendipity by way of the Preferences window (see
the section entitled “Configuration Window, Serendipity Setting”).

Edit Window

The edit screens are where you configure the seed
material that the YAV Music Engine uses to gener-
ate your soundtrack. There are four edit screens:
rhythm, melody, texture, and volume. You can
disable or enable synchronization points from any of
the screens. It does not matter in what order you
access these screens. In fact, it is not necessary for
you to access these screens at all (in which case, you
leave all decisions up to the software).

At any time you can press the Next button (triangular
button at the lower right) to go to the Playback
screen. Likewise, at any time you can press the
Previous button (triangular button at the lower left)
to return to the Start window (perhaps, for example,
to change the mood while in kiosk mode — you can
use the menus or keyboard shortcuts to change the
mood when kiosk mode is disabled).

All edit screens have a small button with an icon of a
little computer. Pressing this Computer Choice
button on any edit screen instructs the computer to
generate a suitable configuration for that screen from
the current model. A momentary flash of a red dot
in the upper right of the screen indicates that the
result has not been generated from the current model
but that the serendipity factor has kicked in to
provide something unexpected.

The Rhythm Edit Screen —
Here you define the rhythmic
world of your soundtrack.
Note the storyboard at the top
of the screen.

The Melody Edit Screen —
Here you create the melodic
“seed” that will be used for
all themes and counter-
themes in your soundtrack.

The Texture Edit Screen —
Here you specify which
textures (monophonic,
homophonic, polyphonic,
heterophonic) your
soundtrack will use.

The Volume Edit Screen —
Here you design the volume
curve for your soundtrack.
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It is a good idea to press the Computer Choice buttons a few times to see what sorts of
configurations the software draws from the active compositional model. You can stick
with what the computer chooses for you or you can use one of these as a point of
departure for your own modification.

Note that when you first arrive at the Edit window, Help Circles briefly appear that
suggest an order for progressing through the Edit window. You can disable these help
circles by way of the Preferences window.

Edit Window, Storyboard

Running across the top of the Edit window is a storyboard showing the first frames of the
six main sections of the video clip. Click on a frame to review the section starting with
that frame. These  also represent six of the main synchronization points in this film (in
Hollywood these are called hitpoints). The program recognizes more than two dozen sync
points in this film.

Usually, when you first see the storyboard, all the sync points will be enabled. But if one
isn’t, click on the green button beneath the frame to cause the YAV Music Engine to
synchronize a musical event with that frame. There will be a change of texture, orchestra-
tion, theme, rhythm, or key (or a combination thereof) synchronized with each frame that
you have selected. You can tell that a frame is selected when it appears in color rather
than through a red filter.

Click on the red button beneath a frame to cause the YAV Music Engine to ignore that
particular sync point. The particular section will not have music and this is indicated by a
red filter placed over the frame and the highlighting of the red button beneath the frame.

Click on the little computer button at the right to let the computer make the choice for
you.

When you first see the
storyboard, all the sync
points will usually be
enabled (the green button
under the frame is pressed).
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Edit Window, Rhythm Screen

You are now at the first of the four edit screens, which is the Rhythm screen. The graph in
the middle represents the rhythmic world of the soundtrack.

If you are not at the
Rhythm screen, click the
Rhythm button (the
leftmost square one at
the bottom of the
screen). If you are at the
Rhythm screen, clicking
the Rhythm button will
reset the rhythm graph in
the center of the screen.
Click on the little
computer at the lower
right of the Rhythm
button to have the
computer choose a
rhythmic world for you.

The way the rhythm graph relates to the rhythms that are generated can be difficult to
understand and using this screen effectively will probably take some practice.

For your convenience, there are vertical lines dividing this space into 12 parts. These
roughly line up with the storyboard at the top of the window (two divisions per each of the
six main sections). In fact, they do correspond to the sections they line up with so you can
tailor the flow of the rhythm to the action. This also means that the twelve divisions do not
represent equal time periods, but rather, they represent a period of time equivalent to that
of the main scene to which they correspond.

Click inside the red box around the graph to set up to 12 points in the rhythmic world for
your music. You can drag the blue handles to adjust the graph. Drag handles outside of
the red box to delete them.

Points closer to the center line result in more stable rhythms. As you move toward the
upper or lower edges of the graph, the rhythms become progressively more active and
forward-moving. There is also a greater variety of rhythmic patterns the further you are
from the center. Also, points farther above the center line produce more notes (denser
rhythms) while points below the center line produce less notes (depending upon how far
you are from the center).

Finally, don’t forget that the mood you have selected (Romance, Comedy, or Thriller) will
also affect the types of rhythms that are generated. So, in addition to the considerations
described in the previous paragraph, keep in mind the fact that the Romance mood favors
triple rhythms (e.g., 3/4, 3/2), while the Comedy mood favors duple rhythms (e.g. 4/4, 2/4.
12/8), and the Thriller mood favor nervous quintuple and septuple groupings (e.g., 5/8,
5/4, 7/8). Further, the frequency of specific rhythmic patterns is governed by your choice
of mood.

The graph in the center of
the Rhythm Edit screen lets
you define the rhythmic
world of your soundtrack.

Consider using the
Computer Choice button to
generate you rhythmic world
for the first few soundtracks.
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Edit Window, Melody Screen

Press the Melody button (the second to the leftmost square button at the bottom of the
screen) to proceed to the Melody screen.

If you are not at the
Melody screen, clicking
the Melody button takes
you to the Melody screen.
If you are at the Melody
screen, clicking the
Melody button erases the
melody on the musical
staff in the center of the
screen.

The Melody screen lets you enter a melody of three to twelve notes to use as a "seed" for
your music. Click on or around the musical staff to enter notes. Drag a sharp or a flat to a
note to raise it or lower it by a half step. You can also drag notes up or down to adjust
them. Drag the natural sign onto a sharped or flatted note to revert the note. Click on the
treble clef sign at the left of the staff to audition your melodic seed.

Press on the little computer button at the right of the Melody button to let the computer
create a melody for you.

The mood that you have selected on the Start window affects what variation techniques
are applied to your melodic seed for the purpose of extending it to create themes,
counterthemes, and chordal progressions.
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Edit Window, Texture Screen

Press the Texture button (the second from the rightmost square button at the bottom
of the screen) to proceed to the Texture screen.

If you are not at the
Texture screen,
clicking the Texture
button takes you to
the Texture screen. If
you are at the Texture
screen, clicking the
Texture button resets
the texture choices in
the red box in the
center of the screen.

The Texture screen lets you choose which textures your music will use. Music can be
made of solo lines (monophony: a single melody at a time), chords (homophony:
several melodies playing in the same rhythm), counterpoint (polyphony: several
melodies that retain their independence), or melodies with accompaniment
(heterophony: a primary melody with a subordinate accompaniment).

Reading left to right, these four textures are represented by the icons in the center of
the red box (solo, chordal, counterpoint, melody with accompaniment). Clicking on
any of them lets you specify whether or not that particular texture will be used in your
music. Click on the little computer button at the right of the Texture button to let the
computer make the choice for you.

A red circle with a line through it indicates that a texture is disabled and will not
occur in your soundtrack. Note that at least one texture type is required so you cannot
disable all the textures. Having only one texture enabled forces your soundtrack to
never deviate from that texture. In such a case, texture will not be used to delineate a
hitpoint.

Enabling two or more types of textures causes the software to generate a texture
stream from the current compositional model. The structure and order of this texture
stream is influenced by the chosen mood.
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Edit Window, Volume Screen

The volume button is the rightmost square button at the bottom of the screen. Click on it
now to proceed to the Volume screen.

If you are not at the
Volume screen, clicking
the Volume button takes
you to the Volume screen.
If you are at the Volume
screen, clicking the
Volume button will reset
the Volume graph in the
red box in the center of the
screen.

At the center of the Volume screen is the Volume graph representing the overall volume
curve of the music for the film. The curve that you describe on this graph is mapped to a
non-linear “MIDI volume curve,” which is much less sensitive at the lower part of the
range than at the top.

Like the Rhythm graph, points on the volume curve do line up with the storyboard at the
top of the window. This allows you to tailor the dynamics to the action. Remember that
the storyboard sections are not equal in duration, so equidistant points on your volume
graph do not necessarily represent equal time periods, but rather, they correspond to a
period of time equivalent to that of the main scene under which they are placed.

Click inside the red box around the graph to set up to 12 volume levels for your music.
The closer your line is to the top of the box, the louder the music will be at that point in
time. You can drag the blue handles to adjust the graph. You can also drag the beginning
and end points. Drag handles outside of the red box to delete them.

When you reset the graph to a flat line by clicking the Volume button, that flat line
represents a level of 96 on a scale of 0 to 127, which is mezzo forte or medium loud.

Click on the little computer button at the right of the Volume button to let the computer
create a volume curve for you.
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Composing your Soundtrack

To have the YAV Music Engine create a soundtrack from your choices on the edit
screens, simply press the triangular Next button at the lower right of the screen. This
starts the composition process, which takes between 5 and 10 seconds. You are
informed of what is going on at any particular moment by text displayed in the help
field at the lower left and beneath the progress bar, which appears to mark the start of
the composition process.

If “Skip MIDI Check” is disabled in the Preferences settings, the program verifies
every note of your soundtrack for errors. This takes between 5 and 10 seconds; you
can watch the progress bar count down the notes as they are being checked. The
advantage of using MIDI Check is that, should an error be detected, the program
backtracks and makes up to four additional attempts to solve the offending construc-
tion before aborting. You may wish to make use of this verification (i.e., disable
“Skip MIDI Check”) when doing an unattended Batch compose (Batch compose is an
option available in non-kiosk mode that allows you to request any number of
soundtracks to be composed in one operation).
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The Playback Window

Once your soundtrack is finished you are transported to
the Playback window and again, just as when you
arrived at the Edit window, “Help circles” appear
illustrating the logical order to proceed. You may disable
the help circles by way of the Preferences window.

The Playback Window,
Orchestration

A likely orchestration for your soundtrack was already suggested with your initial mood
choice, and you may have noticed that patch changes were sent to your sound module in
preparation for playback. At this point you are advised to visit the Preferences window
and click on the “Decrement Patch Numbers by One” checkbox. This will assure you that
your sound module is set up correctly and automatically makes the appropriate settings if
it requires its patches to be decremented by one.

Upon arrival at the Playback window you can see the “badge” of the current ensemble
type in the upper left corner of the screen.

The six default orchestrations categories

1) Keyboard(s)  — pianos, electric pianos, harpsichords, etc.

2) Chamber Trio — a wind instrument, bowed stringed instrument(s), and plucked or struck stringed
instrument(s).

3) String Ensemble  — bowed and plucked stringed instruments with a variety of bowings. Occa-
sionally, a keyboard or harp is part of this ensemble.

4) Chamber Ensemble  — strings, keyboard (synth pads), woodwinds, harp, French horn(s), timpani
and a number of variations thereof.

5) Jazz Band  — keyboard, acoustic bass, acoustic guitar, mallets (usually vibraphone),
saxophone(s), percussion, trumpet, trombone, and other brass as needed.

6) Pop Combo  — Electric guitar, electric bass, synthesizer, and drums.
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Within each category there are hundreds, sometimes thousands of variations, some
subtle and others striking. You have a number of options to change the orchestration.

While at the Playback screen in kiosk mode and even during playback, moving the
cursor in and out of the ensemble badge at the upper left (without pressing the mouse
button) triggers a new variation on the current ensemble (if you are not in kiosk
mode, hold the optionKey down while moving in and out of the badge to trigger a
variation on the current orchestration). Clicking the mouse button on the ensemble
badge cycles through the six orchestration categories listed above. The badge changes
accordingly. You may also use these controls during playback.

Another way to change
the ensemble category
is to press the Orches-
tration button (with a
French Horn on it) at
the bottom of  the
screen. This brings you
to the Ensemble-picker
screen which pictures
all the ensembles
together.

As with all the controls in the Edit window, there is a little computer choice button
immediately to the lower right of the Orchestration button (although there is no
computer choice button on the Orchestration screen itself). Pressing this instructs the
software to generate an ensemble from the current compositional model. This can,
from time to time, produce collections of instruments that are not possible to achieve
in the ways described so far.
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The Playback Window,
Playing your Soundtrack

Now that your soundtrack is ready you can audition it with or without the video. The
button with the ear on it plays your soundtrack without the video, and the button with the
eye on it plays the video without the soundtrack.

Of course, the most interesting thing to do is to press the button with the ear and the eye
on it because this plays the video with your soundtrack. If you believe that your
soundtrack is out of sync with the video, you may wish to open the Preferences window
and change the “Delay in Ticks” setting (one tick is 1/60 of a second).

After experiencing the video with your soundtrack there are many options: you can save
your soundtrack to the archives, you can generate a new soundtrack with the same
settings, you can generate a new soundtrack with the same settings but different mood,
you can quickly generate a new soundtrack with all new settings generated by the
computer, or you can return to the edit screens and tweak a few parameters here and there
(to return to the Edit screens press the triangular “Previous” button at the lower left of the
screen).

If you are not in kiosk mode, there are a number of other options (available from the
menus) as well: you can export your file to a standard MIDI file outside of the archives,
you can save your settings as a settings file, you can save your settings as a preset, or you
can change the default settings of The Music is the Message to the settings that generated
the current soundtrack.
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Generating New Soundtracks from
the Playback Window

To generate a new soundtrack using exactly the same settings click on the leftmost
square button at the bottom of the screen (the one with miniature versions of the four
edit screen buttons).

To generate a new soundtrack using all new settings which, themselves, are generated
from the current model, click the small “Computer Choice” button to the lower-right
of the leftmost square button at the bottom of the screen.

To generate a new soundtrack with the same settings but a different mood, click on
one of the three “Mood Switch” buttons at the upper right of the screen, but make
sure you choose a different mood (the current mood is highlighted), otherwise the
effect is the same as clicking on the “New Soundtrack, Same Settings” button (the
leftmost square button at the bottom of the screen).

Note that when you generate a new soundtrack with the same settings but a different
mood (as described in the previous paragraph), often your rhythmic world will have
to be re-interpreted. This is because the collection of available rhythms is somewhat
different for each mood. Your actual rhythm graph does not change, only the underly-
ing “rhythmic space” to which it is applied.
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Saving Your Soundtrack

Press the triangular “Next” button at the lower right of the screen. If you have not already
done so, a dialog asks if you would like to save your soundtrack. Confirm this. You are
then asked if you felt the soundtrack was low, medium, or high quality. The software
uses this rating to decide which files to factor into its compositional model the next time
it “learns.”

Note that a soundtrack requires at least one high-quality rating before it is considered
worthy of the learning pool. Further, a single low rating for a soundtrack that has a single
high rating cancels out the high rating.

If you are not running in kiosk mode and you consider your soundtrack to be extremely
good (or extremely poor), you can add extra points by holding down the shift key to
double the effect of your rating, the option key to triple it, or the command key to
quadruple it.

Your soundtrack is automatically named (sequentially) and saved as a standard MIDI file
in the Archives folder inside the MIMfiles folder. A settings file with the same name
(prepended with an S) is saved in the Settings folder inside the MIMfiles folder. The
settings file contains all the settings used to generate this soundtrack. The MIDI file is
either a type 0 SMF or a type 1 SMF, depending upon your choice in the Preferences
window.

If you are in non-kiosk mode, you can “Open” settings to reload them by way of the
“File” menu. You can also save settings as one of the sixteen presets. Additionally, you
can “Save” settings files and MIDI files with names of your choosing (although this must
not be saved in the Settings or Archives folder maintained by the program, meaning those
that are in the MIMfiles folder).
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The Archives Window

Having saved your soundtrack, you are brought to the Archives window where you find a
scrolling list of all soundtracks that have been saved to date. Depending upon your
settings in the preferences (Archives Help enabled or disabled), “Help Balloons” may
display as you move the cursor around. The soundtrack that you most recently saved is the
last one at the bottom of the list. The “R,” “C,” or “T” at the end of the file’s name
indicates whether it is a Romance, Comedy, or Thriller soundtrack.

Selecting a soundtrack
from the scrolling list
brings you to the
Archives Playback
screen with a play
button and stop button.
Press Play to hear the
selected soundtrack
while watching the
video. Press Stop to
interrupt playback at
any time.

Press the triangular Previous button in the lower left to return to the Archives list, where
you can select another soundtrack or retrace your steps back through the Playback
window and edit screens if you like.

Pressing the triangular
“Next” button at the
lower right of the
Archives Playback
screen (or on the
Archives list screen)
takes you to the Credits
screen, and a click on
the “Next” button from
there brings you back
to the Start window. Note: Returning to the Start

window (when in kiosk
mode) initializes all settings
and in some cases re-
generates configurations of
the edit screens.

Congratulations!

You have now completed the first part of the tour. You now explore other functions
of the software. These include the Configuration window, the learning process, and
the menus available in non-kiosk mode.

Pressing the mouse button
while the cursor is over the
word “Archives” will bring
up the Archives Management
popup menu if you are
operating in non-kiosk mode.
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4 Configuration

The Configuration window is where you set up preferences for The Music is the Mes-
sage, including how and when the software “learns” from your collection of soundtracks
(in the Archives folder) and settings (in the Settings folder). To open the Configuration
window select “Preferences” from the “Utilities” menu (you may need to hold the
optionKey down to access the menubar while in kiosk mode) or select “Preferences”
from the “File” menu if you are not in kiosk mode. The main options are described in
clockwise order around the window.

At the upper right are the settings that allow you
to enable or disable the Help Circles and Archive
Help. These have been discussed earlier. Below
these is a setting for “Time-out.” This refers to
the duration of a period of inactivity that will
trigger the program to go into Screen Saver
mode. You lose all your current settings when
this happens, so it may be best to disable this
feature unless you are in kiosk mode.

At the lower right are controls for MIDI and the
sound effects. These have been discussed earlier
in this tour. The “MIDI Check” refers to the note-
by-note verification of your soundtrack. You can
probably disable this unless you discover that a
particular model is producing problems. How-

ever, remember that you are strongly advised to click on the “Decrement Patch Numbers
by One,” because this tells you whether or not your General MIDI device requires its
patches to be decremented by one. You may need to use the volume slider to adjust the
level and mix of the sound effects. Note that this slider has no effect whatsoever upon the
volume of your soundtrack, which is all MIDI data and subject to your settings on the
Volume screen discussed earlier.

At the lower left are controls that you might need in a kiosk situation to automatically
shut down the computer, for example, at a certain period of time prior to the power being
shut down for the building. These can be set on a daily basis with a different shutdown
time each day or as the same shutdown time for every day of the week.
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The Configuration Window,
Learning Setup

The most important part of the Configuration window is the Learning setup in the
upper left. The learning process enables the software to adapt its compositional
models to your particular tastes or, in the case of a multi-user situation, to the tastes
of a group of people.

In kiosk mode, it is normal to enable the software to “Auto-Learn” at a certain time
each day. Keep in mind that the learning process can be lengthy; up to 20 or 30
minutes. You have a choice of a circular progress display, a text-only progress
display, or a spinning (“busy”) cursor without a progress display. Because of the
graphics involved in the circular progress display, it adds the most time to the
learning process. The busy cursor option is the fastest, although it is not much faster
than the text-only progress display.

Before starting the learning process, the software makes a backup of the current
model in the Models folder inside the MIMfiles folder.

The button labeled “Now” starts the learning process immediately. Again, recall that
this process can take between 5 and 20 minutes and should not be interrupted. If you
do need to interrupt the learning process, the software attempts to load the most
recent backup model. If it fails to do so, you will be asked to locate a model the next
time you launch the software.

Models (folder)

There are other models in the Models folder with which you can experiment. The
“Load Model” and “Save Model” buttons let you quickly exchange models.

The models come to play whenever you press one of the little Computer Choice
buttons. Then, the current model is consulted to generate a configuration. The current
model is also used to generate an orchestration when you first select a mood from the
Start window.

You can see that the model plays a large part in the generation of seed material and,
in some cases, can be completely responsible for the generation of all seed material.
During the composition process the model is consulted to determine the rhythmic
structure (down to the durations of individual notes), overall form, texture stream, and
tempo. The YAV Music Engine develops other aspects of the composition without
consulting the model. Future versions of this software will integrate the music engine
more closely with the model, so that the model will also be consulted to determine the
methods used to transform the melodic and harmonic material.
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The Configuration Window
Serendipity Setting

The Serendipity setting is mainly used in conjunction with the “Computer Choice”
buttons. When you press a “Computer Choice” button, there is a chance that you will
produce a random configuration rather than a configuration generated from the currently
active compositional model. The serendipity setting defines the probability that such a
random configuration can occur.

At one end of the range, the setting of “None” guarantees that every click on a “Com-
puter Choice” button results in material generated from the current model. At the other
end, “Total” guarantees that the model is never consulted when the “Computer Choice”
buttons are pressed.

Between “None” and “Total” are “Normal,” “More,” “Less,” and “Random.” The various
probabilities for non-generated (random) configurations at these settings are: Normal =
6% to 24%; More = 9% to 39%; and Less = 3% to 15%. A setting of Random simply
chooses a random probability from 0 to 100%.

Probabilities of Randomness by Serendipity Setting
Total Serendipity 100 %

None (No Serendipity) 0 %

Normal Serendipity 6 - 24 %

More Serendipity 9 - 36 %

Less Serendipity 3 - 15 %

Random Serendipity 0 - 100 %
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5 History

You can get to the History screen by pressing the “History” button at the bottom of
the Configuration screen. Alternatively, if you are in non-kiosk mode, you can get
here by selecting “History” from the “Windows” menu.

Use the controls in the history window to view either the ratings file or the user
history.

First press the Update button to read in the User History file and the MIMratings file.

Once the files have been read in, the upper field
displays the entire file (or the most recent 32k of
it), while the lower field displays the subset you
request via the controls in the middle of the
screen.

When viewing the ratings, the only applicable
controls are the “R,C,T” filters which let you
view only the Romance, Comedy, or Thriller
ratings in the lower field.

The History screen can display
and filter ratings from the
MIMratings file.
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When viewing the user history, you can filter by date using the popup menu in the center
of the screen.  Use the “Active Time” button to display the amount of time spent using
the software on the currently selected date. Use the “Total” button to display the total
time spent on the software to date.

Note that the user history is mainly intended to
monitor use in kiosk mode, as not all user events
are logged in non-kiosk mode.

Start time is given at the beginning of each line.
The last two items of each line are end time and
total elapsed time for session.

Note that the first line of the complete history
usually indicates the most recent date of backup
(and learning when in constant kiosk-mode).

User History
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The abbreviations used in the user history are as follows (the numbers next to the
abbreviations indicate how many times that action or control was used):

User History Abbreviations

Hlp = Quick Help

Pre = Preview screen

Syn = Sync buttons on storyboard

Rhy = Points clicked on rhythm graph

Mel = Notes entered into melody staff

Tex = Times clicked on texture buttons

Vol = Points entered on volume graph

Cmp = Compositions (pressed Next button from Edit screen)

Ins = Accessed instrument screen

Aud = Played soundtrack without video from Playback window

Vid = Played video without soundtrack from Playback window

ALL = Played video with soundtrack from Playback window

Rec = Recomposed new soundtrack from Playback window

SmR = Switched mood to Romance and composed new soundtrack

SmC = Switched mood to Comedy and composed new soundtrack

SmT = Switched mood to Thriller and composed new soundtrack

SMF = Saved soundtrack to Archives

Pck = Picked any soundtrack from Archive scrolling list

PMF = Played file chosen from Archives scrolling list

Timout = Allowed software to time-out.

ERROR = A software error occured (the object that caused the error is indicated)
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6 Menus

In kiosk mode you only have three menus available: the Apple menu (which is also
available in non-kiosk mode), the Options menu (which groups together useful functions
from several of the non-kiosk mode menus), and the Help menu (which is also available
in non-kiosk mode).

Apple Menu

The first two items under the Apple menu pertain to
The Music is the Message.

About The Music is the Message

This takes you to the Credits screen.

Help...

This opens the online Help window. There are other ways to get to this Help window. For
example, if you select any menu item with the option key and the command key pressed,
you will see the “menu-help” cursor and the item you select will open the Help window
to information about that menu item. Alternatively, you can jump to any section of the
online help by way of Apple’s Help menu (see following). While you are in the Help
window, you can iconize the window (to keep it floating around for instant access) by
pressing its zoom box. It will shrink to a flowing icon of a question mark.

Options Menu (kiosk mode)

The Options menu is the main menu available
in kiosk mode. Depending upon your configu-
ration in the Preferences window, you may
need to hold the option key down while
moving the mouse to the top of the screen in
order to reveal the menubar. Because all the
items in the Options menu are drawn from
other menus, they are described elsewhere.
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Help Menu

The Help menu is available in both the kiosk mode and non-kiosk
mode.

About Balloon Help

Show Balloons

These first two items are the standard options provided by Apple
under the Help menu. At this time, there are no help balloons in The
Music is the Message.

The next sixteen items provide you with instant access to their
corresponding pages in the Online Help window.

Overview

Quick Tour

Technical Information

Menus

File

Edit

Windows

Configure

Soundtrack

MIDI

Utility

Not to be confused with the Options menu previously described.

Internet

Configuration

History

About QuickHelp

Shortcuts

QuickHelp

QuickHelp is the on-screen help summary accessible
by clicking the question mark button at the bottom of
most screens. Its availability by way of this menu is
simply a convenience.
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File Menu

New

This brings you to the Start window and lets you begin working on a
new soundtrack.

Open

Open lets you open a settings file and configure the edit screens to the
settings in that file. If you happen to be in the Playback window when
you open a settings file, a new soundtrack using that file’s settings will
be composed immediately.

Save...

This lets you save a settings file to another folder than the Settings
folder and with another name than the ones that are automatically
generated by archiving your soundtrack. Note that an R, C, or T is
automatically appended to your file name to indicate the current mood.

Page Setup...

This displays the normal Page Setup dialog.

Print

This prints the current window.

Help...

This brings you to the Help window. Note that you can select any menu item with
the option and command keys pressed to access help for that item.

Quick Help...

This opens the QuickHelp reference page, a single page of descriptions of the main
program functions (move the cursor over an item to read about it and click to exit)

Preferences...

This opens the Configuration window, where you can set preferences for the pro-
gram and view the user history.

Quit

This quits the program.

Full Menus (non-kiosk mode)

The full menus become available when you switch to non-kiosk mode. To switch to or
from kiosk mode, uncheck Kiosk mode from the Options menu (when in kiosk mode) or
from the Utility menu (when in non-kiosk mode). Alternatively, press command-U to
toggle between the two modes.
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Edit Menu

With the exception of Clear, the Edit menu is not currently used by this software.

Undo

Cut

Copy

Paste

Clear

If you happen to be in an Edit Screen (Rhythm, Melody, Texture, or Volume), this
will reset the current screen after first asking for confirmation. Contrast this to the
options on the Configure menu, which reset the current screen without confirmation.

Select All

Windows Menu

Selecting an item in the Windows Menu brings you to a window or screen of
the item you selected.

Start

Preview

Rhythm

Pitch

Texture

Volume

Instruments

Playback

Archives

Configure

History
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Configure Menu

Mood

Select from one of the following three moods
to impose the constraints associated with that
mood upon your soundtrack (see the Techni-
cal Information in the Help for the nine
parameters that are affected by changing the
mood). The background changes color to
indicate which mood the software is in.

     Romance

The background turns red.

     Comedy

The background turns yellow.

     Thriller

 The background turns blue.
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Sync Points

     All On

This enables all syncpoints (hitpoints).

     SyncList

Selecting a point from this submenu disables that syncpoint.

       > Sync 1

       > etc.

Rhythm

     Clear Rhythm

This resets the rhythm graph to a flat line.

     Generate Rhythm

 This generates a new rhythm graph from the current model.

     Random Rhythm

This generates a random rhythm graph.

Melody

     Clear Melody

This erases the current melodic seed.

     Generate Melody

This generates a new melodic seed from the current model. The melody will
be played if you are not at the Melody Screen (press the option key if you are).

     Random Melody

This generates a random melodic seed. The melody will be played if you are
not at the Melody Screen (press the option key if you are).

     Preview Melody

Previews the melodic seed (it there is none, one will be generated).
This is the same as clicking on the treble clef.
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Texture

     Allow All

Allows all four texture types to participate in the texture stream.

     Generate Texture Set

This generates a collection of textures from the current model.

     Random Texture Set

This creates a random collection of textures.

(Configure menu — continued)

     TextureList

Choosing textures
from this list toggles
their presence.

        > Monophony (solos)

        > Homophony (chords)

        > Polyphony (counterpoint)

        > Heterophony (melody with accomp.)

Volume

     Clear Volume

This levels the volume to a flat value of 96 (= mezzo forte) out of a possible 127.

     Generate Volume Curve

This generates a volume curve from the current model.

     Random Volume Curve

This creates a random volume curve.
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Instrumentation
In all cases, choosing an ensemble generates a collection of patches from the current
model and sends those patches to your sound module.

     Random (generated) Ensemble
This chooses a random ensemble based upon the current model.

     New Variation on Ensemble
This creates a variation within the current ensemble category.

     EnsembleList
Choose any ensemble from this submenu to make it active.

       > Keyboards

       > Chamber Trio

       > Strings

       > Chamber Ensemble

       > Jazz Band

       > Pop Group

Serendipity
This setting defines the probability of the software creating a brand new configuration
from an edit screen or otherwise generated parameter that is not generated from the
currently active model.

     SerendipityList
Choose a setting to
specify serendipity
within the indicated range.

       > Normal
6% to 24%

       > More
9% to 39%

       > Less
3% to 15%

       > Total
100% (No settings generated from the model)

       > None
0% (All settings generated from the model)

       > Random
0 to 100%
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Soundtrack Menu

Play Video

This plays the video track without the soundtrack.

Play Audio

This plays the soundtrack without the video.

Play Video with Audio

This plays the video with the soundtrack.

Stop Video and/or Audio

This stops the video and/or the soundtrack.

New Soundtrack

These options all provide shortcuts to generating
new soundtracks without having to return to the edit
screens. They are, for the most part, self-explana-
tory. Remember that the word “Generated” in this
context means that the currently active model is
used as a basis to generate all settings for the new
soundtrack. The word “Random” in these options,
applies to all settings as well.

     Same Settings, Same Mood

     Random Settings, Same Mood

     Generated Settings, Same Mood

     Random Romance

     Generated Romance

     Random Comedy

     Generated Comedy

     Random Thriller

     Generated Thriller

Save Soundtrack to Archives

This saves your soundtrack to the Archives (provided a soundtrack has been created).
You will be asked to evaluate your soundtrack before saving it.
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MIDI Menu

Export MIDI File...

This provides a way to export your
soundtrack as a MIDI file without
having to save it to the “official”
Archives (or after having saved it to the
Archives). Note that this will be a type 0
or type 1 Standard MIDI file, depending
upon your settings in the Preferences.

Play MIDI File...

This is a convenience item that lets you
quickly play any Standard MIDI file.

Channel 1 Sound

This and the following seven items let you change patches on the desig-
nated channels. Note that you may need to select “Decrement Patches by
One” in the Preferences if you hear unexpected results.

etc.

MIDI Setup...

If you are not using MIDI Manager, this option allows you to set up your
MIDI output (assign it to the Modem or Printer port at a speed of your
choosing).

All notes off

This stops any stuck notes and also stops any currently playing MIDI files
whether they are soundtracks or MIDI files you have triggered with the
Play MIDI File... option in this menu. Note that using this while a
soundtrack is playing with video stops the MIDI soundtrack but not the
video. Use the appropriate item under the Soundtrack Menu to stop both
the video and the audio.
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Utility Menu

Batch compose

This allows you to create a batch of soundtracks
(as many as you like) with a single menu selection
(you will be asked how many soundtracks to
compose and whether or not to vary the instrumen-
tation for each one).

Your new soundtracks are saved to the archives, so
after running a Batch Compose you should count
back from the bottom of the scrolling archives
field the number of files requested and start

auditioning the soundtracks from that point. Alternatively, you could simply make a note
of the number of the last soundtrack immediately prior to running a batch compose. Note
that none of the batch-composed files have any ratings assigned to them.

Because you will be composing quite a few soundtracks, it will take some time. This
option is the sort of thing you may want to start running right before you take a break.
Batch composition makes heavy demands of your computer’s processor and memory.
Because of this, requesting large numbers of soundtracks (25 or more) may cause a crash.
It is best to work up to the large numbers gradually to see how much your computer can
handle. Otherwise, give as much memory as possible to this software.

The options are self-explanatory. Remember that “Generated” in this context refers to
generating all settings from the current model and “Random” in this context refers to
using random settings for all parameters.

 > Same Settings, Same Mood

 > Random Settings, Same Mood

 > Generated Settings, Same Mood
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Presets

You can save the current setting as a “Preset” by
selecting one of the 16 preset subMenu options with
the option key down. Note that the program comes
with presets already installed, so you may want to
experiment with these first. You can select a preset
with the command key down to make it the default
startup setting for the entire program.

 > Select with OptionKey to Save Preset

 > Select with CommandKey to Set
Default

 > Preset-1

 > etc.

 > Export All Presets...

This exports all 16 presets (or less, if you haven’t used all 16) to a “Preset Bundle”
file. You can name this file whatever you like and save it wherever you desire,
however, the software does maintain a “Presets” folder inside the “MIMfiles” folder
for this purpose.

 > Load Preset Bundle...

This asks you to locate a preset bundle file and replaces all your existing presets with
the presets in that file.
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Learn now

This will immediately commence the learning
process to construct a new compositional
model. Note that this can take up to 20 minutes,
so consider this decision carefully. Also, the
amount of time required for “learning” is
dependent upon the number of files you have
saved to the archives and also which of the
three learning feedback options you have
selected in the Preferences. The circular
progress indicator is the slowest. The text-only
progress indicator is almost as fast as the busy
cursor progress indicator.

Save Model...

This allows you to name and save a file
representing the current model. Note that the
software maintains a “Models” folder inside
the “MIMfiles” folder, but you are not required
to store your models there.

Load Model...

This lets you select a model file to load and make current.

Set Default Model

This lets you select the current model or another file as the default model for the soft-
ware. If you have set a default model for the program, this model will be loaded every
time you start up the program (as long as the model file can be located... i.e., don’t move
it).

Backup all files

When “Auto-learn” is enabled in the Preferences, the software maintains a backup of all
the Settings, Archives, Ratings, and User History files. This Backup is kept in a folder
named “MIMBU” inside your Preferences folder. Selecting this item from the menu
makes a backup immediately.

Rate recent soundtrack

This lets you rate or re-rate the most recent soundtrack. The advantage to this is that you
do not have to return to the Archives Playback screen to re-rate a soundtrack. You might
want to use this option to adjust or otherwise manipulate your overall ratings file. You
can quickly review all your soundtracks by option-clicking their names in the Archives
list (option-clicking plays the soundtrack without the video) and then selecting this option
to rate the soundtrack. Note that there are several menu options that remove the most
recent soundtrack from memory and that if there is no soundtrack in memory, this option
will not have any effect.

(Utility menu — continued)
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Load recent soundtrack settings

This is primarily for use in conjunction with the Archives. If you hear something you
like in the archives,  you can use this option to load the settings for that file immediately,
without having to remember the name of the most recent soundtrack you auditioned.

Clear Ratings File

This clears all the ratings inside your ratings file (with double confirmation). Use this
with care, because the software requires your soundtracks to be rated in order for it to
construct its model files. At least one file of each mood must have at least a rating of 1 in
order for a model to be constructed (therefore you must have a minimum of three files).

Kiosk mode

When checked, the menubar and menus are not visible at the top of the screen unless
you move the mouse up to that region while holding the option key down (you can
remove the option key requirement using Preferences). When the software is in kiosk
mode, the menubar (when exposed) only contains two menus. Uncheck “Kiosk
mode” to reveal all the menus available to the software and use the program to its
fullest potential.

Hide Finder

This allows you to hide the Finder behind a backdrop. If your screen is 640 by 480,
this has no effect, because all the windows are that size and will naturally cover up
the Finder.

Internet Menu

The items on this menu takes you to various Music is
the Message sites on the world wide web. You must
either be using Internet Config or have Netscape
running in the background for these options to work.

Music is The Message homepage

Online documentation

Online tutorial

Latest version

www.yav.com
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Archive Management Popup Menu

While in the Archives window in non-kiosk mode,
pressing the mouse button down on the word
“Archives” at the upper left reveals the “Archive
Management” popup menu.

The options available from the Archive Manage-
ment menu are self-explanatory. It may be practical
to think of many of these options as if they were a
filtering mechanism for what is displayed in the
scrolling soundtrack list.

Play or Stop current file

If the currently selected soundtrack is not playing,
this initiates playback (without the video), other-
wise it stops any current playback. This is the same
as clicking on a file name with the option key
pressed (to start playback), or pressing the enter
key during playback (to stop playback)

Play soundtrack with video

This takes you to the Archives Playback screen
with the currently selected soundtrack loaded for
playback. This is the same as pressing the enter key
(when no file is playing).

Show current file rating

This displays a small field containing the rating of
the current soundtrack below the scrolling
soundtrack list. This is the same as clicking on a
soundtrack name with the shift and command keys
pressed.

Rate current file

This brings up the program’s standard soundtrack rating dialog allowing you to specify a
“Low,” “Medium,” or “High” rating to a file. This is the same dialog you get using the
keyboard shortcut: command-backslash (\). Remember that holding the shift key down
while pressing “Low” or “High” doubles your rating, holding the option key down triples
it, and holding the command key down quaddruples it.

Set current rating...

This brings up the alternate rating dialog which asks you to specify an exact rating for the
file (this can be a positive or negative number). Rather than being added or subtracted
from the current rating, this value replaces the current rating.
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Load settings of current file

This loads the settings of the currently selected soundtrack. This is the same as
pressing command-right bracket (]) or clicking on the soundtrack name with the shift
key pressed.

Delete current file

This deletes the currently selected soundtrack file, its associated settings file, and its
entries in the ratings file. You will be asked for confirmation before proceeding. This
is the same as clicking on the soundtrack name with the command key pressed.

Show All

This restores the scrolling soundtrack list to display all soundtracks currently archived
in the Archives folder. Select this option while pressing the option key to force a
(slightly longer) complete examination of the ratings file if you suspect that repeated
deletions and reorderings may have corrupted the resulting list.

Show only highest

This shows only the highest rated soundtracks in the Romance, Comedy, and Thriller
moods. If several soundtracks have the same rating, those with identical ratings are
displayed.

Show high range...

This asks for a number (good choices are within the range of 2 to 4) and then displays
only the soundtracks for that many of the top ratings. For example, if you requested
the top 2 ratings, you would see files that are within the highest two ratings of
Romance, Comedy, and Thriller soundtracks in the scrolling soundtrack list. Note that
if several soundtracks have the same rating, those with identical ratings are also
displayed. Consider this scenario: 10 is the highest soundtrack rating; multiple
soundtracks might have a rating of 10 and multiple soundtracks might have a rating of
9. All soundtracks rated 10 or 9 willbe displayed. Because different moods typically
have different high ratings, the absolute value of the top two rating categories usually
varies from mood to mood.

Show only ratings above...

This allows you to specify a cut-off rating value for the soundtracks that are displayed
in the scrolling soundtrack list. Unlike “Show high range,” the numbers entered here
are absolute rather than relative to the mood.

Show soundtracks with ratings of...

This option lets you single out soundtracks of a specific rating.
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Delete below range...

This is similar to “Show high range...” (see above) except that all files below the indi-
cated value are deleted.  Note that this deletes the actual MIDI files (in the Archives
folder), the associated settings files (Settings folder), and all entries for that file in the
“MIMratings” file. You will be asked to confirm this action. After using this option it is
often a good idea to use the “Renumber...” option.

Delete below value...

This asks you for a rating and deletes all soundtracks with ratings below that value. Note
that this deletes the actual MIDI files (in the Archives folder), the associated settings files
(Settings folder), and all entries for that file in the “MIMratings” file.  You will be asked
to confirm this action. After using this option it is often a good idea to use the “Renum-
ber...” option.

Renumber...

After having performed a “Delete below...” (see above), you probably have many gaps in
the numbering of your archive files. Renumber will renumber all your files, so that they
are consecutive again. The soundtrack (MIDI) files are renumbered along with their
associated settings files and also their entries in the MIMratings file. It’s a good way to
“clean house.” The next soundtrack you create will start with the next number beyond the
highest renumbered soundtrack.

Sort by name

This sorts the scrolling list of soundtracks by name. It does not reorganize the list of files
in the actual MIMratings file.

Sort by mood

This sorts the scrolling list of soundtracks by mood. It does not reorganize the list of files
in the actual MIMratings file.

Sort by rating

This sorts the scrolling list of soundtracks by rating. It does not reorganize the list of files
in the actual MIMratings file.

Zero all ratings...

This equalizes all ratings. It doesn’t actually “zero” the ratings because the learning
process (described elsewhere in this document) requires at least one file of each mood to
have a minimum rating of 1. So this menu options sets all the ratings of all the files to 1,
which is effectively the same as zero-ing them. Use this with caution, particularly if you
have carefully rated hundreds (or thousands) of soundtracks. Remember, the ratings are
crucial to the construction of the compositional models.

Important note: see “Keyboard Shortcuts” for other tips on managing your Archives.

(Archive Management — continued)
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Using Archive Management
The sample files in the “Archive Collections” folder were all created using the
Archive Management popup menu.

We started with 536 soundtracks. These included soundtracks created on two of our
development machines as well as soundtracks created by the first two months of users
of the kiosk version at the newMetropolis Center for Science and Technology.

Some of the soundtracks had been rated by museum goers and some of them had been
rated by people working in or passing through our office.

We made another pass through all the soundtracks, examining their ratings (using
shift-command up- or down-arrow) and re-rated those that required it (using com-
mand-backslash).

Finally, we created the Mufasa 536 model. Examining the model (using tools that are
not provided with the release version of the software), we noted that only the top
seven ratings were included for each mood. Armed with that information, we used the
“Delete below range...” option (with a value of 6) to filter out all but the top six
ratings. This left 173 files which we then renumbered the files to produce the Mufasa
173 soundtrack set and model.

Next we used the “Delete below range...” option (with a value of 5) to filter out all
but the top 5 ratings and created the  Mufasa 135 soundtrack set and model. We
continued this procedure to derive the Mufasa 81, 45, 22, and 11 sets.

Having decided to include only 24 sample soundtracks with the default installation of
the software, we loaded the Mufasa 45 set (to do this, we simply replaced the Ar-
chives and Settings folders in the MIMfiles folder with the Archives and Settings
folders in the “Mufasa 45 complete” folder which is inside of the “Archive Collec-
tions” folder).

Next we scrutinized these soundtracks more closely and re-rated them. We used the
“Sort by rating” option to place them in descending order of “quality.” This made it
easy to start from the bottom of the list and delete the soundtracks of lower ratings
(by clicking on the soundtrack’s name with the command key pressed or selecting
“Delete soundtrack” from the popup menu) until we were left with only 24
soundtracks (eight in each mood).

We then created a new model using the “Learn now” option from the Utility menu
and created one, completely generated, soundtrack using that model. This became the
25th soundtrack in the scrolling list of sample soundtracks.
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7 Technical Information

More about moods and models

When first starting The Music is the Message, people sometimes wonder why the music
doesn’t always sound romantic, comedic, or thrilling. This is because it needs to gather
data from its user or users for the purpose of constructing composition models, and that is
also why it asks users to rate the quality of their soundtracks and the quality of other
soundtracks that may have been loaded from the Archives screen.

The software needs to collect a representative sample before it starts taking action on
what it has learned. This is a continual process, but it is essential that a “critical mass” be
reached before dramatic effects are perceived. Actually, this process is not unlike what
takes place in the popular music industry. Musical styles are driven and pressured to
evolve in certain directions through the constant “opinion polls” that the publishers and
record industry conduct in the form of sales reports and top-40 charts.  With The Music is
the Message, a lengthy learning process can be circumvented by loading in a pre-existing
model.

The learning process goes on behind the scenes — in kiosk mode, this can be set to occur
automatically once per day — so that the users are only aware of the results of the
process and not what is actually going on.

This means that, as the software learns more and more about the public opinion of its user
or users, it begins to move closer and closer to the collective (majority) opinion of what
the words “romantic,” “comedic,” and “thrilling” mean to the actual users. The more the
software is used, the more it learns. It’s an ongoing process... For example, if the users
are, for a certain period of time, predominantly professional drummers, this will defi-
nitely tip certain balances for a while until the cross-section of the users stabilizes.

The greatest effect of this analysis-feedback-loop will be heard by people who opt to
leave choices up to the software (including impatient people who skip over everything
and go right to Playback). Choices that are made by the software become increasingly
more “intelligent” as the software learns more about what produces the best results (to
the ears of the humans and as expressed by the data collected in the “opinion polls” the
software conducts).

Initially, the software’s compositional model will have a somewhat lesser impact upon
those users who choose to exercise a greater degree of control when configuring the six
parameters (sync-points, rhythmic-world, melody-seed, texture-constraints, volume-
curve, and instrument ensemble) to actually influence the outcome and shape it to their
own personal vision of how that particular music should sound. Such experimentation,
when successful, can have an extremely beneficial effect upon the model — just remem-
ber to give such successful soundtracks an appropriate rating when asked.
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More about built-in constraints

Certain constraints are automatically invoked by choosing a specific mood. Whenever
a user chooses romance, comedy, or thriller, the software applies the most common
characteristics of film music in that mood to the following ten (10) parameters:

Mood-dependent Constraints

Meter: Romance tends toward triple meters, Comedy favors duple meters, Thriller uses more
polyrhythms (uncommon meters like 5 and 7).

Tempo:  Romance is the slowest, Comedy is the fastest, Thriller runs the gamut from slow to fast.

Key and mode:  Romance tends toward harmonic-minor, Comedy toward major, Thriller favors
atonality.

Harmonic progression  (chordal relationships between sections): As would be expected from
the differing keys and modes of the various moods, the pool of harmonic progressions is tailored
to each mood.

Perceptual “distance” between the seed melody and the generated counter-melodies:  (the
user will perceive a wider variety of variations for the Comedy... that is, the variation techniques
are more complex for the Comedy mood than for the Romance mood, and these create
variations that are more difficult to immediately perceive as related to the seed material.

Form:  Grouping of the 24 sub-scenes (deliniated by film cuts and action) into a perceivable
musical form. How many formal “chunks” do we perceive is mood-dependent. Romance favors a
recapitulatory “sonata-rondo”-like form. Comedy favors and arch-like form. Thriller favors a non-
recapitulatory, progressively forward-moving form.

Structural (leitmotif) relationships  between the 24 sub-scenes. Most leitmotif associations
with characters are upheld regardless of the mood (Romance, Comedy, Thriller), however, the
relationship between scenes without characters and the focus motif of some charactger shots
changes dependent upon the mood.

Texture placement (whether from the user-chosen or computer-generated set of textures): The
final texture stream may consist of up to 24 changes of texture depending upon the mood.

Thresholds for interpreting the user’s (or the computer-generated) “rhythmic world:”
Each point represents a distance closer to or farther from stability (the flat line in the center) and
invoking a different mode will invoke a different rate of change (which can be visualized as a
curve) as applied to the interpretation of the rhythmic world. Additionally, that graph represents
note-density, which itself is similarly affected by mood choice. Likewise, the frequency of
sustained notes is directly related to mood.

The default instrumental category is mood dependent:  Romance uses the chamber trio as
its default, Comedy defaults to the jazz band, and Thriller chooses between chamber ensemble
and string ensemble. Following this choice, the actual instrumental makeup of the particular
ensemble is determined by way of the currently active model.

Beyond these tenfixed constraints (regarding which the user has little or no control),
the other factors of making the music lean toward their personal view of “romance,”
“comedy,” and “thriller” are left to their experimentation with the controls provided
for them. That’s why it becomes important to give the software time to “learn” and
continually adapt to the (collective) user’s taste.
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Observations:

The Music is the Message demonstrates that music can force an interpretation upon a
scene that has a inherently polyvalent dramaturgy. The Music is the Message is not
attempting to disprove one of the film industry’s strongest laws: that “music cannot save
a scene which has inherent dramatic faults.” In this case, the scene does not need to be
“saved.”

It is a common misconception that “music can save a scene.” Young directors are often
deluded with the idea that they can hire a great composer to repair an otherwise defective
scene. In the film industry, it is well known that no matter what music is behind a scene,
no matter who wrote it, and no matter how good it is, it cannot compensate for a scene
that has cinematic or dramatic problems (the rule is “you can never fix it with the
music”).

It is best not to approach the software with a too heavily preconceived notion of what
type of music is associated with the concepts of Romance, Comedy, and Thriller.
Consider romance for a moment. For some people this has happy associations, for others
it has tragic associations.

Approaching any film with too strong feelings about the music often leads to disaster in
the real world too. The most famous case of this phenomenon is Kubrick’s “2001.”
Kubrick watched the film with a temp-track made of existing records pulled at random by
the music-editor, and in the end he couldn’t get the sound of the temp-track out of his
head. Subsequently, he was forced to license all that pre-recorded music and pay off the
already contracted composer (Alex North) for what would have been a much more
suitable soundtrack.

This has happened many times in the film industry (Alien, Breaking Away, The Exorcist,
The Graduate, Platoon, The Sting). Note that this is not related to what transpired with
The Shining, where the decision to use Bartok’s music was made in advance and the film
was cut (edited) to the music rather than the other way around (which is the normal case).

When we think about this in the context of a polyvalent scene like the one used by this
program (which is extremely well suited for the types of experiments that the software
makes possible), one shouldn’t forget that there is a good deal known about what film
music can and cannot do and that, particularly with respect to comedy, music cannot
make a scene any funnier than it inherently is and this is a fact of life. The program has
generated some soundtracks that do make this scene seem comedic, but nothing is going
to make it into the “Charlie Chaplin farce” that might be a requirement for some people’s
comedic ideal.
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On the other hand, because we have heard the software create truly comedic
soundtracks for this clip, as well as truly romantic and thriller soundtracks, we are
confident that as the software responds to its user or users and learns both from the
users’ choices and also from their feelings about music generated by choices left up
to the software it will gradually approach the ideal model for these moods with
respect to this particular clip.

Don’t expect the software to already know what your favorite romantic music is.
Remember, you must teach it what you like and it will learn from you.
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8 Keyboard Shortcuts

General
← or → Pressing the left or right arrow key is equivalent to pressing
the “Previous” or “Next” button. When you are in the “Start” window
(which does not have a “Previous” or “Next” button), pressing the right
arrow key activates one of the Mood Choice buttons chosen at random and
takes you to the Edit window.

Â or ‹ Pressing the return or enter key starts or stops playback of a
soundtrack in appropriate windows (Play, Archives, Archives Play). Note
that this does not stop playback of a Standard MIDI File you may have
selected from the “MIDI” menu. To stop playback initiated from the
“MIDI” menu, press command-period, or command-comma.

¤ Ò plus menu item: Select any menu item with the option and
command keys pressed to access help about that menu item (the cursor will
change to the Help cursor to remind you of this fact).

Help Window
Ú Zoom Box: To put the Help window in “Standby” mode, click
the zoom box at the upper right corner of the Help window.

Edit Window
Ò plus Next button: Going from the Edit window to Play window only.
Normally, using the “Next” button on an Edit screen to go to the Play
window creates a new soundtrack. Hold the command key down while you
click the Next button to go from the Edit window to Play window without
creating a new soundtrack.

Archives Playback Window
Ò plus Previous button: Going from the Archives Playback window
to the main Archives window with the command key pressed will avoid the
request to rate the most recently experienced soundtrack.

While in the Archives Playback window in non-kiosk mode, click the
current file name (at the top of the screen) for more information about that
file. Hold the option key down while clicking for even more information.
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Archive Window
¤ Ú To play an Archived soundtrack immediately, without
viewing the video, click on the list of soundtracks with the option key
down.

Í Ú To load or reload a soundtrack’s settings from the
Archive list, click on the file name with the shift key down.

Ò Ú To delete a file from the archives (which also deletes its
associated “Settings” file and entries in the “MIMratings” file), click on
a file name with the command key down (confirmation is required).

Í Ò Ú To display the current rating for a file, click on the file
name with the shift and command keys down.

↑ or ↓ To select the next or previous soundtrack, press the up or
down arrow keys. Use the up or down arrow keys in conjunction with
any of the above options.

Â or ‹ Pressing the return or enter key while in the Archive
window with a soundtrack selected (highlighted) in the scrolling list
sends a mouse-click to the selected soundtrack. It is as if you clicked
upon the soundtrack name in the scrolling list. The following tip clari-
fies why this behavior can be useful.

Tip: To change the keys held down for the current file, hold the new
keys down and press the return or enter key.
For example, hold the shift and command keys down (to display the
ratings) and progress down the list using the down arrow key. When you
arrive at a file that you are curious about, release the shift and command
keys and press, for example, the option key followed by the enter key to
audition the file just as if you had clicked upon it with the option key
held down. If you want to view the soundtrack with the video, release
the option key and press the enter key again. If you feel the file needs a
higher or lower rating, press command and backslash (\).  If you want to
load the settings of that soundtrack, press command and right bracket (])
or, if you are still on the screen with the scrolling list of soundtracks,
hold the shift key down (assuming your soundtrack is still selected) and
press the enter or return key.

While in the Archives window in non-kiosk mode, pressing the mouse
button down on the word “Archives” at the upper left will reveal the
“Archive-management” popup menu. This is discussed elsewhere in the
documentation.



5 8 T h e  M u s i c  i s  t h e  M e s s a g e

Apple Menu
Ò H Help....

File Menu
Ò N New
Ò O Open
Ò S Save....
Ò P Print
Ò H Help....
Ò ? Quick Help....
Ò = Preferences...
Ò Q Quit

Edit Menu
Ò Z Undo
Ò X Cut
Ò C Copy
Ò V Paste
Ò A Clear

Windows Menu
Ò D Rhythm
Ò M Pitch
Ò W Texture
Ò L Volume
Ò I Instruments
Ò G Playback
Ò F Archives
Ò = Configure

Menu Shortcuts
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Configure Menu
Ò R Romance
Ò K Comedy
Ò T Thriller
Ò 1 Generate Rhythm
Ò 2 Random Rhythm
Ò 3 Generate Melody
Ò 4 Random Melody
Ò 5 Preview Melody
Ò 6 Generate Texture Set
Ò 7 Random Texture Set
Ò 8 Generate Volume Curve
Ò 9 Random Volume Curve
Ò 0 Random (generated) Ensemble
Ò - New Variation on Ensemble

Soundtrack Menu
Ò J Play Audio with Video
Ò . Stop Audio and/or Video
Ò B Save Soundtrack to Archives

MIDI Menu
Ò E Export MIDI File...
Ò , All notes off

Utility Menu
Ò \ Rate recent soundtrack...
Ò ] Load recent soundtrack settings
Ò U Kiosk mode

Preset Menu
¤ plus menu item: Saves preset to selected preset number

Ò plus menu item: Sets selected preset to default setting for program
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